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1. INTRODUCTION

1.	Click the link in the email to go to the login page of the self-service environment or go there directly via

This manual contains information about how you can view and manage your company settings.

2. Login here with your username and password.

https://office-essential.t-mobile.nl/login
3. Click login to log in.

1.1 LOGIN
As soon as you have an active account on the platform, you will receive a welcome email from us. It
contains a link to the self-service environment as well as yourusername.

Tip: Keep your username in a safe place, as it cannot be changed.

If you are logging in for the first time or have forgotten your password, please go to Request Password.
Go to the "request/forgot password" section for more information.

1.2 LOGOUT
If you have finished changing the settings, click Logout at the top right corner to log out. Your changes will
be saved automatically.

1.3 REQUEST/FORGOT PASSWORD
If you want to log in for the first time or have forgotten your password, you can request a new password via
Telepo's login page.
1. Click Request password
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2. 	Enter your username and click Request Password. You can find your username in the welcome email
you received. Please note that this cannot be changed.

4. Choose a new password and enter it twice. Then click Change my password.

3. 	You will receive an email with a verification token within a couple of minutes.
Copy this in the Token field and click OK.

5. Go to the login page and use your username and new password to login. Click Login.
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1.4 INTRODUCTION TO MENU OVERVIEW
After you log in, you will be taken to the main screen. At the top of the gray bar, you will find the menu.
You can navigate from here. Each item has a number of sub-items. Move your mouse over the items or
select an item to navigate to one of the sub-items.

In the top right corner, you can switch between Admin Portal and User Portal. If you want to return to the
Admin Portal, you will need to re-enter your password for security reasons. A detailed explanation of
the options available on the User Portal can be found in the end user manual.
1

2

3

4

5

6

The menu is made up of the following items:
Item
1

Home

General information about the Essential application and
personal information of your user account.

2

Services

Settings for managing contact lists and working hours.

3

Organization

For setting voice prompts.

4

User Administration

User settings.

5

Function numbers

Group level settings such as ACD groups, hunt groups,
IVR and schedules.

6

Devices

SIP phone settings.
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2. HOME

User Photo

The Home section contains general information about the Mitel application as well as personal

Click Upload Photo to upload a photo.

You can upload a photo here, so your colleagues can see what you look like.

information about your user account. Home is made up of two parts: About and My Profile.
Change Password

2.1 ABOUT

You can change your password here. Enter your old password and then enter your new password twice.

On the About page you will find the end user license agreement.

Click Change password.
Change PIN Code
Here you can set the PIN, you use to login to a fixed phone. This is especially useful if you use flex places.
In that case, you will not have a fixed workplace but will have a fixed phone on your desk.
You can then use your PIN to log in to that fixed phone. On this page, you can change your PIN. Enter your
current PIN first and then enter your new PIN twice. Click Change PIN to change your PIN.

2.2 MY PROFILE
The My Profile page contains information about your user account, divided into:
§ Personal Info
§ Directory Field (displayed in the case of end user accounts only)
§ User Photo (displayed in the case of end user accounts only)
§ Change Password
§ Change PIN Code (displayed in the case of end user accounts only)
Personal Info
This contains the user's name, phone numbers and email address.
Directory Field
You can enter additional information here.
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3. SERVICES
The services can be configured for each user, for a group, and/or for the entire organization. This gives you

2. Select the level at which the working hours are to be configured.
a. Organization: To create or manage contact lists at organization level,
select Configure for all users in the organization.

the flexibility to customize the configuration per user and/or per group. The system follows the following

b. User group: To create or manage contact lists at group level, select a group under User group.

logic to determine the settings: User > Group with the highest priority > Organization.

c. U
 ser: To create or manage contact lists for an individual user, enter part of the first name or last
name in the search field. Click Search.

3.1 CONTACT LISTS
The Contact Lists menu allows you to create and manage contacts and shortcuts. It is possible to do so for
the entire organization, for a user and/or a user group. These contacts and shortcuts will then be visible in
the users' contact list.

NB: A maximum of 75 contacts can be displayed in a contact list at a time.
Search results are shortened to 25 contacts.
Contacts can be managed at:
1. Organization level (by the administrator in the Admin Portal)
2.	Group level (by the administrator in the Admin Portal). If a user is in more than one user group, the entire
contact list will be displayed.
3. User level (by the administrator in the Admin Portal or by the user in the User Portal).

3.	You are presented with two options: Mandatory Contacts and External Contacts.
We explain these in more detail below:
a. Mandatory Contacts

CONFIGURING CONTACTS IN THE ORGANIZATION

		These contacts cannot be deleted by the users. You should therefore only add contacts that are
relevant for all users, such as the general number for Facilities or HR. Users can add their favorite

1. . Go to Services > Contact lists. This is where you can manage the contact list.

contacts via the UserPortal and/or the app. This allows them to manage their contact list.
b. External Contacts
		You can add external contacts here. You can do so manually or by importing a CSV file
(see section 3.1.5).
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ADD A MANDATORY CONTACT

ADD EXTERNAL CONTACT

1. Click Add contact.

1. Click Create new contact.

2. Find the right contact by entering their name in

2. Enter the contact person’s details.

2. the text box or clicking Search contact to add a
2. contact from the list.

3.	Click Add this contact to save the contact
as Mandatory Contact and return to your
home screen.

DELETE A MANDATORY CONTACT
1. Click the X to the right of the contact.

3. Add one or more phone numbers by clicking Add phone number and complete the fields:
§ Select the type of contact at Type.
§ Add the phone number at Phone number.
§ Add a short number at Abbreviated number, if you so wish.
This will only work if you are calling from a fixed phone or softphone.
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4. Click Save to save.

3.2 DIRECTORY INFORMATION
Directory Fields are additional fields that allow you to add more information to internal contacts. As a user, you
can search for that information. For example, the label 'Department'. You can add these fields via the menu
item User administration > Directory Fields. You can control the authorization of users and/or groups who are
allowed to use this search option and which fields they are allowed to see under Directory Information.
AUTHORIZING USERS AND/OR GROUPS
1. Go to Services > Directory Information.
2. You will be presented with the following options:
• To configure the authorization for all users, click Configure for all users in the organization.
• To configure the authorization for a group, click on the name of the group under User group.

3. Configure the following:
• What groups can search directory information: Select one or more groups that are authorized

to search.
• What groups can search field: Select one or more groups that are authorized to search the

IMPORTING A CSV-FILE
Use the Import contacts option to import several into the system at the same time.

Please note:
§ The user data may contain special characters. The server uses the UTF-8 standard.
§ The file may not contain more than 500 contacts.

additional fields.
4. Click Save to save your changes.

3.3 EDIT DIRECTORY FIELDS
Under Edit directory fields you determine the directory field settings. You can specify which fields can be
edited by users. You can do this as follows:

1. Create an Excel sheet with columns for the data to be imported for a user. Use one row per user.

1. Go to Services > Edit directory fields.

2. In the File menu click Save as...

2. The following options are available in the main window.

3. In the Save as list, select separated by semicolons.

• To edit the directory fields for an organization, click Configure for all users in the organization.

4. In the File menu click Save as...

• To edit directory fields for an individual group, click on the name of the group under User group.

5. Select UTF-8 in the Coding list and click Save.
6. The text file can now be imported correctly.
7. In the Admin Portal click Import contacts.
8. Click Browse... to select the correct Excel file.
9. The following data will be displayed:
• Imported contacts - The imported contacts will be displayed.
• Field definitions - Select the value from the drop-down list.
• Position in User Value file - Select the definition from the drop-down list for the contacts displayed.

10. Click Save to save.
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3. Select the fields that can be edited by users.

3.	Configure the option to extend extra working hours. From the dropdown list, select Yes to allow an
4. Click Save to save your changes.

extension of working hours or No if you do not want to allow this. If you leave the option empty, the
system will look at the setting one level up. If the setting at organization level is also empty, this will be
considered to be a No.

3.4 EXTEND WORKING HOURS
Under Extend Working Hours you can indicate which users can overwrite the scheduled working hours
and add extra working hours. They can then arrange this themselves via the User Portal and remain
optimally reachable by phone. The regular working hours can be configured via Services > Working Hours.
CONFIGURE EXTEND WORKING HOURS

4. Click Save to save the changes.

1. Go to Services > Extend Working Hours.
2. Select the level at which the working hours are to be configured.

End users will now see a new Extend Working Hours tab in the User Portal. This allows them to extend
their working day in the event of overtime, so that calls are processed in the normal way and do not switch

	Organization: To decide which users may extend the opening hours, you click Configure for all
users in the organization.

to night mode. At the push of a button, the working day can be extended by two hours. Incidentally, this
does not affect the working hours of the group.

	
User group: To decide which user group may extend the opening hours, you click on one of the
groups under User Group.
	
User: To decide which individual user may extend the opening hours, you enter part of the first or last

A screenshot of how this is displayed in the User Portal is presented below. How this works for the end
user is explained in the User Portal manual.

name in the search field. Click Search.
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3.5 Presence synchronization policies

Type

Activity

Role

On the Presence synchronization policies page, you can specify the rules, for the organization or

Availability In the drop-down menu, select
one of the presence statuses from
the Outlook calendar. The choices
include free, busy, out of office,
working.

From the drop-down menu,
select one of the phone's availability statuses. For example, "not
available (fixed number)". You
can also opt not to change your
phone's availability status. In this
case, you should select "do not
change". Your colleagues will be
able to view your calendar.

Here you can
choose between
private, business
or do not change.
You should always
select "do not
change" here,
as there are no
actions associated
with a role.

Subject

You can link specific words or
letters in the subject field in
Outlook. You can do this by
placing the word or letter between
quotations marks.
Example: Enter "meeting" here
or another random word or letter.
This means that if the word
meeting appears somewhere in
the subject, the availability status
of the phone will be changed to
whatever has been configured at
"Activity".

From the drop-down menu,
select one of the phone's availability statuses. For example, "not
available (fixed number)". You
can also opt not to change your
phone's availability status. In
that case you should select "do
not change". Your colleagues will
be able to view your calendar.

Here you can
choose between
private, business
or do not change.
You should always
select "do not
change" here
as there are no
actions associated
with a role.

Locatie

You can create a label for specific
locations. You can do so by
placing the location between
quotation marks. You can opt for
a specific address or place name
here.
Example: Enter "The Hague"
or "Waldorpstraat 60" here. This
means that if one of the above
terms occurs somewhere in the location field, the availability status
of the phone will be changed to
whatever has been configured
under "Activity".

From the drop-down menu,
select one of the phone's availability statuses. For example, "not
available (fixed number)". You
can also opt not to change your
phone's availability status. In
that case you should select "do
not change". Your colleagues will
be able to view your calendar.

Here you can
choose between
private, business
or do not change.
You should always
select "do not
change" here
as there are no
actions associated
with a role.

Private

Here you can opt to link a meeting in the calendar with "private"
status to the availability status of
your phone.

From the drop-down menu,
select one of the phone's availability statuses. For example,
"not available (fixed number)".
You can also opt not to change
your phone's availability status.
In that case you should select
"do not change". Your colleagues will be able to view your
calendar.

Here you can
choose between
private, business
or do not change.
You should always
select "do not
change" here
as there are no
actions associated
with a role.

specific user groups, based on which you want the accessibility by phone to be linked with the Outlook
calendar. You can create the link in four different ways: by subject, presence status, location, or private
status. Please note that this option is only available when you have purchased the Calendar Integration

Match

add-on.
1. Go to Services > Presence synchronization policies.
2. The following options are available on the home screen:
• Organization: If you want to configure the calendar integration policy for the entire organization,

click on Configure for all users in the organization here.
• User group: If you want to configure the calendar integration policy for specific user groups,

click on the desired group under User group.
3. Select the Outlook calendar from the dropdown menu at Select connector.

4.	Add rules to configure the calendar integration mapping. You can add multiple lines by clicking
+add rule. The Presence Synchronization Policies are read top-down. This means that the first rule
is the most important one. The next line will only be read and applied if the previous one is not in force.
Below you can see how to configure the mapping. At exclude from mapping and calendar view you
can also exclude lines from the mapping. For example, "private meetings". You can add this by clicking
+Add exclusion.

5. Click Save to save the changes.
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3.6 WORKING HOURS
Under Working Hours, you can configure the working hours of the end-users. You can determine what
should happen when someone calls the end-users' fixed number.

NB: These settings do not apply to group numbers (function numbers) and mobile numbers.
You can configure the opening hours of group numbers via Function numbers > Schedules. If the
user is linked to a group number and the group schedule is 'open', the user will still receive incoming
calls from the group, even though his work schedule is set to 'closed'.

Example:
If a user belongs to multiple groups with different schedules for the same day, the user's schedule will
be the same as that of the group with the highest priority. Suppose a group with priority 3 has scheduled working hours between 8:00 and 15:00. Another group with priority 5 has scheduled working hours
between 10.00 and 19.00. Then the result will be a schedule from 8.00 to 15.00 for a user belonging to
both groups. However, if the priority 3 group did not specify any working hours for that particular day,
the result for that user would be between 10:00 and 19:00.
If neither schedule contains any working hours for that day, the hours from the organization schedule
will be used. If you do not specify working hours, then the standard working hours from the organization schedule will be used. If, on the other hand, you want to specify that the users of the group are not
working at all, you should check Do not work checkbox for that specific day.

Night mode
Outside working hours, incoming calls will switch to night mode. By default, this means that all incoming

CONFIGURE WORKING HOURS

calls are forwarded to the personal voicemail.

1. Go to Services > Working Hours.
2. Select the level at which you want to configure the working hours.

Prioritization

• Organization: Configure the working hours for the entire organization?

You can define a schedule at different levels: for an individual user, for a user group, or for the entire

• Click Configure for all users in the organization.

organization. If a user belongs to multiple user groups with different schedules, the schedule will be taken

• User group: Configure the working hours for the users in a group?

from the group with the highest priority.

Click on the name of the group.
• User: Configure the working hours for an individual user?

The ultimate schedule for a user will be a combination of the schedule for the organization, the schedules

Enter part of the first or last name in the search field. Click Search.

defined for the user groups to which the user belongs, and the individual schedule for the user. The
regular working hours defined in the individual schedule have a higher priority than the schedules defined
at group level. These, in turn, have a higher priority than the schedules defined at organizational level.
However, exceptions and extra working hours (additions) are combined at all levels in the final schedule.
Extra working hours (additions) have a higher priority than exceptions.
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3. Enter regular working hours.

5. Add Additions

	The organization's time zone is displayed on this page. If you want to change it, you can do so via

	Besides exceptions, it is also possible to add extra working hours to the regular working hours.

Organization > Local. By default, the Europe/Amsterdam time zone is active.

For example, during a specific sales campaign or extra-long opening hours temporarily apply for specific
users or user groups. Please note that extra working hours have a higher priority in the system than

	Enter the opening hours per day. For example, Monday through Friday from 9.00 to 18.00. If you leave

exceptions.

your fields empty, the system will first check to see if any opening hours have been configured at a
higher level. If the fields at all levels are empty, the default setting will be closed.

Click Add to add extra working hours.

	When you configure the working hours for a group or a user, the Not working checkboxes are available.
These checkboxes are not available at the organization level.
At group and user level		

At organization level
6. Click Save to save the changes.
REMOVING EXCEPTIONS OR ADDITIONS
If you want to remove configured exceptions or extra working hours, click on the red cross in the top right
corner of the specific setting.

Click OK to confirm your change.

4.	Add Exceptions. Click Add to add exceptions, such as Christmas, Easter, etc. Then choose the year and
the month. If the exception falls on the same day every year, then choose Every by Year.
You can add multiple Exceptions.
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4. ORGANIZATION

To make it possible to record a prompt, the system will call a phone number. You need to enter that

4.1 VOICE PROMPTS

prompt. Hang up and the prompt is automatically saved and added to the list of Voice prompts.

At Voice Prompts you will find a list of all the voice prompts you can use. The caller will hear these
prompts, for example as soon as he is forwarded. Voice prompts may be available in multiple languages.
Click on a voice prompt to see the corresponding description. To listen to a voice prompt, click Play.
The voice prompt will then be downloaded as a WAV file and can be played back via a media player.

number at Phone number and click Initialize call to have the system make the call. Pick up and record the
• Click Save to save the voice prompt.

ADDING A VOICE PROMPT
1. Click on New Voice Prompt.
2. Give the voice prompt a name.
3. Add a description of the voice prompt.
4. Add the WAV or AIFF file by clicking Import the file.
You can also record a prompt directly by clicking Record the file.
Enter the name of the voice prompt and the description on the screen that appears.
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5. USER ADMINISTRATION

LIST OF USERS

User Administration allows you to view and change user settings.

In addition, you will see recent activity on the platform. For example, when someone last downloaded an

For each user, you will see the username, the first name, the last name, and the primary line.
app or logged into the portal. The colors of the icons have a specific meaning:

5.1 DIRECTORY FIELDS

• Green: last login date.

Under Directory fields, you can create Directory fields: fields that you can enter or add yourself, such as a

• Orange: the date on which the app was downloaded on a device.

label for buttons. It is possible to do this for up to a maximum of 14 directory fields. You can determine the

• Pink: the date on which the user received an invitation for the app on a device.

name and type of each field.
Look for a specific user/user group
If you are looking for a specific user, you can use the search bar to do so. You can search by username, first
name, last name, phone number (fixed and mobile), and alias. You can also search by user group by selecting
a desired group from the dropdown menu in the top right corner.

5.2 DIRECTORY FIELDS MODERATION
Users can report errors in the Directory fields. For example, a colleague works in Support but is
listed in 'Marketing'. All requests for changes like this are submitted to Directory fields moderation.

SEND A NEW WELCOME MESSAGE

As the administrator, you can accept the proposed changes.

1. Select the desired user(s) to which the welcome message should be sent.

5.3 USERS

3. Select the device to which you want to resend the welcome message and click OK.

2. In the list go to

and click Send Welcome message.

Under Users, you can find all users. Select a user and click the cogwheel icon to perform an action.
For example, directly add the selected users to a group, or remove them from a group. Change users or
send them an email relating to the use of telephony and tablets.
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DOWNLOAD ALL USER INFORMATION IN CSV

Under Diversion, you can configure diversions for users. This allows you to create a diversion to another

1. Select the desired user(s). To select all users at once, check the top checkbox.

number without there being a special presence status attached to this. This can be configured separately

2. In the list go to

for each mobile and fixed number. For each number you have the following options:

and click

3. You can now open and save the file.

• Divert to (no condition)
• If a line is busy, divert to
• If a call is not answered within 30 seconds, divert to

Tip: Make a CSV data file readable in Excel
1. Open the CSV file in Excel.
2. Highlight the entire A column by clicking on the letter A at the top of the column.
3. Click 'Data' in the top menu bar.
4. In the 'Data' menu, select 'text to columns'.
5. In the opened window, select 'separated' and [next].
6. In the next window, select 'semicolon' and [next].
7. In the next window, select 'Default' and click [Finish].

• If a line is unavailable, divert to
Configure a diversion number:
1. Click Diversion number to configure a diversion number.
2. Click Apply to save the change.
Activity diversion links a diversion number to a presence status. Link a diversion number to a status:
1. To do this click Add activity diversion.
2. Then select the activity during which the call is to be diverted to the diversion number.
3. Enter the diversion number.

USER DETAILS

4. Click Save to save the change.

The details of a user become visible when you click the user in the list. Good to know: the username
cannot be changed, and the password and PIN are not visible. However, it is possible to reset the
password and PIN. Click Reset password/PIN to enter a new password or PIN. At Cost center, Language,
Timezone and Visibility you can configure the preferences for the individual user.
At User presence, you can change the current role and activity of a user. As soon as the activity is set to
'not available', you can enter an end date and time at Set activity expiration.
At Set future presence you can configure the future availability of a user.
If a user wants to enter a personal note for other users, this can be entered at Personal note. This personal
note will then be visible in this user's profile.
The Group login status option ensures that the user logs in directly to all groups to which he belongs.
These groups are configurable at Function numbers.
Configure the Caller ID to configure the user's caller ID.
1. Click Caller ID.
2. Select the number the user wants to use to dial out.

The photo that the user has used in their profile is shown at Photo. Click Change photo to change it

3. Click Save to save the change.

• To remove the photo, click Remove photo from user
• To add a photo, click Choose File and select the appropriate file.
• To see a preview, click Preview after adding the file.
• Save the photo by clicking Save photo.
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For the options below, the changes you make here will only be saved when you click Apply and Save at the

Under Personal lines, you can see which phone numbers are associated with this user. There is always a main

bottom of the page. If you have made changes that do not need to be applied, click Cancel.

number; the primary line. Behind the number, you can see whether this is a mobile or a fixed number. Some
users also have a secondary number associated with them, the secondary line. Fixed numbers can also be

Information on the basis of which a user can be found can be entered at Searchable directory

linked to a short number. In this case, you will be able to find it under Alias and there will be a check next to

information. You can enter the following here:

the Short number option.

• The first name: First name.
• The last name: Last name.

Under Personal phones, you can see via which devices the user can be reached: a softphone, a mobile phone,

• The user's department: Department.

a SIP desktop phone, or a SIP phone that was not supplied by T-Mobile.

• User's email address: E-mail address.
• New search terms: Field 1, 2 and 3.
At Displayed directory information (not searchable) you can add information to the user's profile that is not
searchable. This is additional information for other users that is only visible at the profile. Under Roles, User
group membership, and Barring Group, you can add the individual user to different roles, user groups, and
barring groups. Check the appropriate groups.
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6. FUNCTION NUMBERS

Distribution of calls

6.1 ACD GROUPS

How many agents should
be called in parallel

Here you can configure how many users should be called in parallel.

Which phones can an agent use
to receive calls

Here you check on which devices users can receive calls: softphone,
fixed phone and mobile phone.

After how many seconds of
ringing should the call go to next
agents

Here you can configure for how many seconds a call rings before it is
forwarded to the next user.

ACD (Automatic Call Distribution) groups distribute incoming calls to users who are logged in to the
ACD number. The call distribution, queue, overflow, etc. of a group can be determined based on various
settings.
You cannot create a new ACD group yourself. Please contact your contact person at T-Mobile for this.
However, you can change the settings of an existing ACD group yourself. You can do so as follows:
1. Click the number of the ACD group to change the settings.
2. Change the settings below:
General settings
Numbers

This is the phone number associated with the ACD group. You
cannot change this field yourself. If you want to change this number,
you can submit a request to Cloud Business Operations.

Name of this group

This is the name of the ACD group.

Override this with diverted call
metadata

Check this to ensure that the data of the diverted number is visible to
the user receiving the call.

Distribution settings
Distribution settings

Here you can configure whether incoming calls should be distributed
by priority or by skill level. In the latter case (Distribute calls by skill
level), the skill level is displayed next to each user. You can change
this by clicking Search or manually adding users based on user ID,
first name, or last name. You can use the arrows to change the order.
If you do not want to configure a priority or skill level when it comes
to the distribution of calls, you should not enter anything.

Agent settings
How many seconds minimal
resting time does an agent get
between calls

T-MOBILE ADMIN PORTAL MANUAL
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Overflow when call arrives
How many calls can be queued
at the same time

Here you can configure the maximum number of calls that can be
queued at the same time.

Overflow when longest
wait time exceeds

Here you can configure how long (mm:ss) it takes before the queue
is considered to be 'full'. The time runs from the moment the first
caller is placed in queue. When the queue is full, incoming calls will
no longer be distributed to the users.

What happens when a call is
received, and queue is full
or maximum wait time is
exceeded?

Here you can configure whether the incoming call will get to hear a
busy tone or will be diverted when the queue for the ACD group is
full or the maximum wait time has been exceeded.

If forward is selected, to what
Here you can configure the number to which the call should
number should call be forwarded be forwarded.

Handling of queued calls

Voice prompts
What should caller hear,
when placed in queue

Here you can configure which prompt or sound callers will hear as
soon as they are placed in queue.

What should caller hear,
when in queue

Here you can configure which prompt or sound callers will hear as
soon as they are in queue.

What progress message should
caller hear

Here you can configure which progress message callers will hear.

How often (in seconds) should
progress message be played

Here you can configure every how many seconds the progress
message will be played.

Should caller hear ringing
when call is distributed to agent

Check this if you want callers to hear a ringtone as soon as the call
is forwarded to an agent.

Play queue position

Check this if callers need to be told their position in the queue.

Play estimated wait time

Check this if callers need to be told the estimated wait time.

Forward call when the caller
has been waiting longer than
(minutes(:seconds))

Here you can configure how long (mm:ss) it takes before a call
is forwarded.

Alternate between progress
message and queue position/
wait time

Check this if callers alternately need to be told their position in the
queue and their wait time.

When call been waiting too
long, where should call be
forwarded

Here you can configure the number to which the call should be
forwarded, when the caller has been waiting too long.

Do not play queue wait time
if time is less than

If you do not want callers to be told their wait time if this is less
than a specific number of minutes, you can enter the number of
minutes here.

No agents available forward
number

Here you can configure the number to which calls are to be
forwarded to if no agents are available (or logged in or on 'available'
status).

Do not play queue wait time
if time is more than

If you do not want callers to be told their wait time if this is more
than a specific number of minutes, you can enter the number of
minutes here.

How many distribution attempts
to agents are allowed

Here you can configure the maximum number of attempts
to distribute calls to users before the call is forwarded.
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3. Press save to save the settings.

6.2 ACD LIGHT GROUPS
ACD light groups (Automatic Call Distribution) distribute incoming calls to users who are logged in to the
ACD number. The call distribution, queue, overflow, etc. of a group can be determined on the basis of
various settings.
You cannot create a new ACD light group yourself. Please contact your contact person at T-Mobile for this.
You can change the settings of an existing ACD light group yourself. You can do so as follows:

Number presentation
Number presentation

User groups
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Here you choose how you want to recognize incoming calls.
You have the following two options:
• Display the hunt group phone number. This way the user will see
that the incoming call is coming from the hunt group and is not a
private call, for example.
• Display the caller's number.
Here you can add users/members to the ACD group. Select the
desired user group here. All members of this group will automatically
participate in the ACD.
It is not possible to create a new user group yourself. You can file a
request for this with Cloud Business Operations.

1. Click the number of the ACD light group to change the settings.
2. Change the settings below:
General settings
Number

This is the phone number associated with the ACD light group. You
cannot change this field yourself. If you want to change this number,
you can submit a request to Cloud Business Operations.

Name of this group

This is the name of the ACD light group.
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Distribution of calls

Overflow when call arrives (Overflow on incoming call)

How many agents should be
called in parallel

Here you can configure how many users should be called in parallel.

How many calls can be queued
at the same time

Here you can configure the maximum number of calls that can be
queued at the same time. This can be no more than 5.

Which phones can an agent use
to receive calls

Here you can check which devices users can receive calls on:
softphone, fixed phone and mobile phone.

Overflow when longest wait time
exceeds

After how many seconds of
ringing should the call go to next
agents?

Here you can configure for how many seconds a call rings before it is
forwarded to the next user.

Here you can configure how long (in minutes: seconds) it takes
before the queue is 'full'. The time runs from the moment the first
caller is placed in queue. When the queue is full, incoming calls will
no longer be distributed to users.

What happens when a call
is received, and queue is full
or maximum wait time is
exceeded?

Here you can configure whether the incoming call will get to hear a
busy tone or will be diverted when the queue for the ACD group is
full or the maximum wait time has been exceeded.

Distribution settings
Distribution settings
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Here you can configure whether incoming calls should be distributed
by priority. You can change this by clicking Search or manually
adding users based on user ID, first name or last name. You can
use the arrows to change the order. If you do not want to configure
a priority when it comes to the distribution of calls, you should not
enter anything.

Handling of queued calls
Forward call when the caller
has been waiting longer than
(minutes(:seconds))

Here you can configure how long (mm:ss) it takes before a call is
forwarded.

When call been waiting too long,
where should call be forwarded

Here you can configure the number to which the call should be
forwarded, when the caller has been waiting too long.

No agents available forward
number

Here you can configure the number to which calls are to be
forwarded to if no users are available (or logged in or on 'available'
status).

How many distribution attempts
to agents are allowed

Here you can configure the maximum number of attempts to
distribute calls to agents before the call is forwarded.
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3. Press save to save the settings.
Voice prompts
What progress message should
caller hear

Here you can configure which progress message callers will hear.

How often (in seconds) should
progress message be played

Here you can configure every how many seconds the progress
message will be played.

6.3 ATTENDANT GROUPS
With the aid of Attendant groups, incoming calls are distributed among users who are logged in to the
attendant number. The following information is visible in an attendant group: the fixed attendant number,
the name of the group, and the call history of the group.
You cannot create a new attendant group yourself. Please contact your contact person at T-Mobile for this.
However, you can change the settings of an existing attendant group yourself. You can do so as follows:
1. Click the number of the attendant group to change the settings.
2. Change the settings below:
General settings
Number

This is the phone number associated with the attendant group. You
cannot change this field yourself. If you want to change this number,
you can submit a request to Cloud Business Operations.

Name of this group

This is the name of the ACD group.

Override this with diverted call
meta-data

Check this to ensure that the data of the diverted number is visible to
the user receiving the call.

Number presentation (incoming number display)
Number presentation

Number presentation
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Here you choose how you want to recognize incoming calls. You
have the following two options:
• Display the ACD group phone number. This way the user will see
that the incoming call is coming from the ACD group and is not a
private call, for example.
• Display the caller's number.
Here you can add users/members to the ACD group. Select the
desired user group here. All members of this group will automatically
participate in the ACD. It is not possible to create a new user group
yourself. If you wish, you can submit a request to Cloud Business
Operations.
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Distribution of calls
How many attendants should be
called in parallel

Here you can configure how many attendants should be called
in parallel.

Which phones can an attendant
use to receive calls

Here you check which devices attendants can receive calls on:
softphone, fixed phone, and mobile phone.

After how many seconds of
ringing should the call go to next
attendant?

Here you can configure for how many seconds a call rings before it is
forwarded to the next attendant.

Handling of queued calls

Overflow when call arrives
How many calls can be queued
at the same time

Here you can configure the maximum number of calls that can be
queued at the same time.

Overflow when longest wait time
exceeds

Here you can configure how long (mm:ss) it takes before the queue
is considered to be 'full'. The time runs from the moment the first
caller is placed in queue. When the queue is full, incoming calls will
no longer be distributed to users.

Forward call when the caller
has been waiting longer than
(minutes(:seconds))

Here you can configure how long (mm:ss) it takes before a call is
forwarded.

Forward number when call been
waiting too long

Here you can configure the number to which the call should be
forwarded, when the caller has been waiting too long.

Forward number when no
attendants are available

Here you can configure the number to which calls should be
forwarded to if no attendants are available.

How many distribution attempts
to attendants are allowed

Here you can configure the maximum number of attempts to
distribute calls to attendants before the call is forwarded.

Here you can configure whether the incoming call will get to hear a
What happens when a call is
busy tone or will be diverted when the queue for the ACD group is
received, and queue is full or
maximum wait time is exceeded? full or the maximum wait time has been exceeded.
If forward is selected, to what
Here you can configure the number to which the call should be
number should call be forwarded forwarded.
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Voice prompts

Number presentation

What should caller hear,
when placed in queue

Here you can configure which prompt or sound callers will hear as
soon as they are placed in queue.

What should caller hear,
when in queue

Here you can configure which prompt or sound callers will hear as
soon as they are in queue.

What progress message should
caller hear

Here you can configure which progress message callers will hear.

How often (in seconds) should
progress message be played

Here you can configure every how many seconds the progress
message will be played.

Play queue position

Check this if callers need to be told their position in the queue.

Play estimated wait time

Check this if callers need to be told the estimated wait time.

Alternate between progress
message and queue position/
wait time

Check this if callers alternately need to be told their position in the
queue and their wait time.

Do not play queue wait time if
time is less than

If you do not want callers to be told their wait time if this is less
than a specific number of minutes, you can enter the number of
minutes here.

Do not play queue wait time if
time is more than

If you do not want callers to be told their wait time if this is more
than a specific number of minutes, you can enter the number of
minutes here.

Number presentation

Here you can choose how you want to recognize incoming calls. You
have the following two options:
• Display the attendant group phone number. This way the user will
see that the incoming call is coming from the group and is not a
private call, for example.
• Display the caller's number.

User groups

Here you can add users/members to the attendant group. Select the
desired user group here. All members of this group will automatically
join the attendant group. It is not possible to create a new user group
yourself. If you wish, you can submit a request to Cloud Business
Operations.

Attendant settings
How many seconds minimal
resting time does an attendant
get between calls

Here you can configure the minimum time interval (in seconds) that
attendants get before the next call rings.

User skills
Distribution settings
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Here you can configure whether incoming calls should be distributed
by priority or by skill level. In the latter case (Distribute calls by skill
level), the skill level is displayed next to each user. You can change
this by clicking Search or manually adding users based on user ID,
first name or last name. Using the arrows, you can adjust the order.
If you do not want to configure a priority or skill level when it comes
to the distribution of calls, you should not enter anything.
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3. Press save to save the settings.

6.4 GROUP INBOX
A Group inbox allows you to configure one general voicemail for multiple users. The following information
appears in the list: the number of the Group inbox, the name of the group, and the group's call history.
You cannot create a new group voicemail yourself. Please contact your contact person at T-Mobile for this.
However, you can change the settings of an existing group voicemail yourself. You can do so as follows:
1. Click the number of the group inbox to change the settings.
2. Change the settings below:
General settings
This is the phone number associated with the group inbox. You
cannot change this field yourself. If you want to change this number,
you can submit a request to Cloud Business Operations.

Notifications (meldingen)
Which groups will receive SMS
notification

You can add the user groups that will receive an SMS here.

What is the name of
this group

This is the name of the group inbox.

Which groups will receive e-mail
notification

You can add the user groups that will receive an email notification here.

Exclude this number from
contact searches

Check this option to prevent the group number being found in
contacts.

Code that identifies this group
inbox when calling group inbox
retrieval number

Here you can configure the PIN that users must enter as soon
as they call the general number of the group inbox. They will
immediately be transferred to the inbox of their group.

Allow anonymous callers to
listen for messages after PIN
authentication

Check this option if you want to allow anonymous callers to listen to
messages after entering the PIN. You can configure the PIN in the
step above.

Greeting prompt

Here you can select the voice prompt to be played as a welcome
message. New prompts can be uploaded via Organization
– Voice Prompts.

Number

Which user groups
are members of this
group inbox
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3. Press save to save the settings.

Check here which user groups are members of the group inbox.
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6.5 HUNT GROUP NUMBERS

Distribution of calls

Hunt groups make it possible to communicate one general telephone number or group number on which
all incoming calls are received. These calls will then be distributed among serveral users or among all

Hunt length

Here you can configure the maximum number of available users
whose phone will ring when the call comes in. Example: You have 5
employees in the associated user group, but you want the phones of
no more than 3 employees to ring when the call comes in. After this,
the call will be forwarded to the chosen fallback number.

Call for how long (seconds)

Here you can configure the maximum time (time in seconds) for
which a phone may ring before the call is forwarded to the fallback
number. Please note that this includes the call setup, so the exact
time the phone rings may be slightly shorter.

Distribution logic

This determines how incoming calls are distributed among the
members of the group. There are two options:

users. You can specify that the users' devices must all ring at the same time or in a random order one by
one. The list contains the Hunt group number, the name of the hunt group, and the group's call history.
You cannot create a new hunt group yourself. Please contact your contact person at T-Mobile for this.
However, you can change the settings of an existing hunt group yourself. You can do so as follows:
1. Click the number of the hunt group to change the settings.
2. Change the settings below:

Sequential: users within the group are called one by one.
The incoming call is forwarded to a random available user in the
hunt group, if they do not answer it is forwarded to the next user, etc.

General settings
Number

This is the phone number associated with the hunt group. You
cannot change this field yourself. If you want to change this number,
you can submit a request to Cloud Business Operations.

Name of this group

This is the name of the hunt group.

User groups

Here you can add users/members to the hunt group.
Select the desired user group here. All members of this group
will automatically participate in the hunt group.
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Parallel: All phones in the group ring at the same time.
The incoming call rings for all users at the same time. The user who
picks up the phone takes the call.
Distribute after how many
seconds

Here you can configure the number of seconds after which the
incoming call will be offered to the next user if the call is not
answered. This option is only applicable if "sequential" has been
selected for the distribution logic.

Fallback number

Under fallback number, you can configure the number to which
the incoming call will be forwarded in the case of "no answer". The
fallback number can only be an internal number. If you do not set a
fallback number and the call is not answered, the caller will receive
the message "The person you are trying to call is not available right
now. Please try again later".

Forward call to fallback number
when closed

Check the checkbox if incoming calls are to be forwarded to
the fallback number when the company is closed.
You can configure the opening hours via the schedule, at
Function numbers > Schedules

Activities that exclude a user
from a hunt

Here you can configure which availability activity will exclude a user
from the hunt group at that time. This makes it possible for every
user to include and exclude themselves from the group.

Exclude users that are in call
from a hunt

Check this option to exclude users from the hunt group as soon
as they are in call. If this option has not been checked, users will
receive a toggle call.

Which phones are used to
receive calls

Here you can indicate from which devices calls can be received.

26

6.6 IVR NUMBERS
Configure an IVR number to connect the caller to the correct user, or user group via a drop-down menu.
The list contains the IVR number, the name of the drop-down menu and the call history of the group.
You cannot create a new IVR yourself. Please contact your contact person at T-Mobile for this.
However, you can change the settings of an existing IVR yourself. You can do so as follows:
1. Click the number of the IVR to change the settings.
2. Change the settings below:
Edit IVR number

Number presentation
Number presentation

Here you choose how you want to recognize incoming calls.
You have the following two options:
• Display the phone number of the hunt group. This way the user will
see that the incoming call is coming from the hunt group and is not
a private call, for example.
• Display the caller's number.

Name of this group

This is the name of the IVR.

Number

This is the phone number associated with the IVR. You cannot
change this field yourself. If you want to change this number,
you can submit a request to Cloud Business Operations.

Extension dialing

This option cannot be used and should therefore not be checked.

Play this voice prompt when
a call is received

Here you can select the voice prompt to be played as a welcome
message. New prompts can be uploaded via Organization >
Voice Prompts.

Preserve metadata from
diverted call

Check this to ensure that the data of the diverted number is visible to
the user receiving the call.

What code identifies this
function number when using
feature code

Here you can configure a feature code which users can use to reach
the IVR number internally.

After the prompt is played…:

When the voice prompt has been configured, the caller can enter the
number associated with the user or user group to be called. Which
user or user group this is can be found under #, *, 0, 1, 2, 3, 4, 5,
6, 7, 8, 9, or - if no choice has been made - under Key listener. If no
number has been entered for a feature code and the caller dials this
feature code, he will be told that this is an invalid option.

3. Press save to save the settings.
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6.7 NUMBER VISUALIZATION
You can see here how the phone numbers for all Function Numbers have been configured. Any changes to
this will be visible as soon as you refresh the web page. Here you can find the configurations below:
• The ACD numbers
• The hunt group numbers
• The IVR numbers
Click on the name of the function number to expand the list.

3. Press save to save the settings.

6.8 SCHEDULES
With a schedule, you can change the accessibility of a function number. Under Schedules, you can create
different schedules. Schedules are handled in a top-down order and the accessibility is determined by the
first agreement. You can rearrange the schedules by selecting and dragging them. The phone number of
the function number is always open by default. This status can be edited. Please note that the Business
Hours of the individual users cannot be configured here.
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CONFIGURING A SCHEDULE
1. Click the function number for which you want to change or configure the schedule.
2. Click Add new schedule event to create a new schedule.
3. Click Edit default schedule event to modify an existing default schedule.
4. Under Name of the event, specify a name for the schedule.
5.	Select the repetition frequency of the schedule. The options are every day, every week
(select which days per week), every month, or every year.
6. Fill in a start and end date (including time) of the schedule at the checkboxes.
7.	Under Prompt, configure the desired prompt when calls come in outside the schedule. You can choose
from the available list. You can add your own recorded prompts via Add new prompt.
8. Click Save to save the schedule.
DELETING AN EVENT
You can delete a scheduled event by clicking the cross next to the relevant schedule event on the righthand side of the list. Next, you must confirm the action by clicking Delete event.
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7. DEVICES

CONFIGURING A SIP PHONE

On the SIP phones page, you will find information about all the Mitel phones linked to your organization.

phone for different options, such as phone numbers, menu options, presence statuses, and call options.

These can be assigned to users or configured as free seating so that they can be used by any user. You

You can add several options for the shortcuts. For example, to simplify certain device features.

Click a SIP phone to view the settings of this unique phone. Here you can configure all the buttons on the

can reboot the individual phones from here and configure them, for example, by programming the keys on
the phone.

Creating Key Lines (L) and Shortcut Keys (S)
1. Choose the type of option associated with each button. This can be a phone number or a function.

7.1 SIP PHONES

2.	Configure the label with which this option is visible on the phone and add the phone number

The SIP phones menu shows the registered phones and configured phones. Each phone has a unique

associated with the option at Value. When configuring the buttons of the phone, the general phone

Mac address. Under Mode, you can see the settings of the phones: Free Seated or Seated (assigned to a

information will be visible.

user). In the case of phones with Free Seating, no Username and User has been configured.

3. Click Save to save all changes. Click Save and Reload to save the changes and reload the phone.

In addition, the type of phone, firmware version, IP address, and status are visible. Phones with a red light
are not logged in to the network and phones with a green light are. Press the cross to remove the SIP phone.

The phone can be completely reset by clicking Reboot Phone. The functions of the various phones are
described in the SIP Phones Manual.
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